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Thank you for purchasing The Boom Box™. 
 
This guide will help you get started using the software. 
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Inside The Box 
 
The Boom Box contains five “best of class” Mac software applications to help you 
personalize and maximize your iPod experience.  You can convert LPs and tapes, capture 
Internet audio streams and download podcasts, and create mixes and your own audiobooks. 
 
Rediscover Your Music 
Convert your LPs and tapes with CD Spin Doctor®.  Import music from a turntable or 
cassette player, detect tracks automatically, reduce noise and enhance the sound quality 
with included filters, and send to your iTunes library. 
 
Your Personal DJ 
Pick any song, artist or album and create playlists to match your mood with MusicMagic™ 
Mixer.  Automatically analyze the sound wave of tracks in your music library, and create 
instant original mixes from songs with similar acoustic personalities. 
 
Hear What You Want… When You Want 
Capture and save the audio from an application with Audio Hijack™.  Save Internet music 
or radio shows to enjoy at any time, capture sound clips from your DVDs, and set timers to 
record even when you’re away from your computer. 
 
Your Own Personal Radio Station 
Download podcasts on thousands of topics and send to iTunes automatically with 
iPodderX™.  Browse and search the largest directory of podcasts from around the world, 
and subscribe to your favorites for fresh, exciting content delivered daily. 
 
Don’t Read It… Hear It 
Turn any written document, e-mail or web page into a spoken audio file using iSpeak It.  
Create your own audio books or listen to the latest news or Internet blog.  Instead of 
reading it – you can now listen to it on your iPod. 
 
 
System Requirements 
 
• Requirements: 

o Macintosh computer  
o Audio input capability (for recording with CD Spin Doctor) 
o Mac OS X v10.3.9 or later 
o iTunes v4.7 or later 
o 50 MB of free disk space to install 
o 1 GB temporary free disk space required for usage 

 
• Optional (but it makes The Boom Box a heck of alot more fun): 

o iPod (any model) 
o Stereo cable (for converting audio with CD Spin Doctor) 
o Internet connection (for Internet stream recording with Audio Hijack) 
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Installing The Software 
 
If you haven’t yet installed The Boom Box, please do so. 
 
Drag the folder called “The Boom Box” to the Applications folder on your hard disk. 
 

 
 
In the new location on your hard disk, open the “The Boom Box” folder.  You will see the 
five applications in The Boom Box.  Choose any one of the five and double-click on the icon 
to run the application.  You will be prompted to enter a CD Key to serialize the software.  
This will serialize all five applications at the same time – you will only need to do this once. 
 
If you purchased a boxed version, the key is on a printed label in the box. 
If you purchased a downloadable version, the key is in the confirmation email. 
 
Optional: You can also drag “The Boom Box” folder from the “Applications” folder to the 
right side of your dock in the area between the vertical separator and the trash can.  This 
will add The Boom Box folder to your dock as a quick launcher to the applications. 
 

 
 

  

Drag this to the Applications 
folder on your hard disk. 
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Rediscover Your Music - Convert LPs and Tapes – CD Spin Doctor 
 
Convert your LPs and tapes with CD Spin Doctor.  Import music from a turntable or cassette 
player, detect tracks automatically, and reduce noise and enhance the sound quality with 
included filters.  Send your converted tracks over to iTunes and transfer to your iPod. 
 
With CD Spin Doctor you can: 
• Enjoy your classic music collection on your iPod. 
• Restore, preserve and archive your music collection. 
• Use tracks from your LPs and cassettes in your iMovie projects. 
 
CD Spin Doctor features: 
• Guided recording sheet for error free recordings. 
• Auto-stop after a fixed time period for unattended recording. 
• Recording quality settings to maximize fidelity and minimize disk space. 
• Filters to reduce hiss, pops and clicks, and restore audio quality. 
• Auto-track definition with preferences to adjust sensitivity. 
• Click & drag track definition and editing. 
• Send converted audio to iTunes and iPod with a single click. 
 
1.  Launch CD Spin Doctor.  Select “New Recording.”  The Recording Sheet appears. 
 
 

 
 
2.  Connect your analog source (e.g., amplifier or cassette player) to your Mac.  
Using a standard stereo connector cable, connect the line-out from your analog source to 
the line-in on your computer and choose “Line In” from the Input Source. 
 
Most Macs have built-in audio input capabilities.  If CD Spin Doctor displays “No Input 
Device Found” you will need to purchase an external input device (such as the Griffin iMic.  

Record 
Audio 
Button 

Auto-Stop 
Timer 

Audio 
Input 
Device 

Input 
Level 

Input 
Meter 

Recording 
Quality 
Levels 
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For more information about connecting your analog source to the computer, see the 
“Recording Setup” addendum at the end of this guide. 
 
3.  Test the levels.  Start playing your audio source.  If everything is connected correctly, 
you will see the input meter lights flash as the audio plays.  The input meter lights should 
display yellow or green, but not red.  If the lights are red, your recording may be distorted; 
move the “Input Volume” slider to the left or adjust the volume on your audio source. 
 
You can choose to hear the source material play through your speaker while recording by 
selecting the “Play Input Through” option.  You can also choose to have CD Spin Doctor 
automatically stop recording after a fixed period of time.  This is ideal if you want to 
perform an unattended recording.  CD Spin Doctor will stop recording at the set time, 
instead of filling up your hard drive with megabytes of silence. 
 

 
 
4.  Stop your audio source from playing, and rewind it if necessary. 
 
5.  Click “Record” in CD Spin Doctor, and then start your audio source.  
“Recording…” will flash while recording.  You can click “Pause” in CD Spin Doctor to pause 
the recording while you switch the LP or cassette to the other side. 
 

Record Button 
 

 

Pause Button 
 

 

Stop Button 
 

 
 
6.  When your source has ended, click “Stop” in CD Spin Doctor.  Click OK to proceed 
to the main CD Spin Doctor window. 
 

 

Filters 
Drawer 

Recorded 
Audio 

Waveform 

Track List 

Auto-
Define 
 Tracks 
Button 

Send To 
iTunes 
Button 
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From this main window you can define tracks, listen to your recorded audio, apply filters, 
and send your recorded audio to iTunes and your iPod. 
 
 
7.  Define tracks. 

Click the Auto-Define button to define tracks automatically. 

 
 
CD Spin Doctor will scan the sound wave of the recorded audio file and identify quieter 
portions, which may represent individual tracks, as seen in the colored rectangles. 
 

 
 
You can adjust the sensitivity of the auto-define process in the CD Spin Doctor preferences.  
This is useful for recorded audio that may normally have more quiet portions than other 
audio, such as classical music. 
 
You can also click & drag anywhere in the waveform to define tracks manually.  You can 
also click & drag to adjust the start point or end point of any track.  To delete a track, select 
it and press the Delete key, or drag it to the trash. 
 

 
 
Double-click on any track to listen to it.  You can use the player controls to stop, pause, 
play, or jump to the beginning or end of a track. 
 
 
 

Defined 
Tracks 

Click and drag to define or adjust 
track start and stop times. 

Defined 
Track List 
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8. Clean tracks. 

Click the Filters button to open the Filters Drawer. 

 
 
CD Spin Doctor includes filters to reduce noise and enhance sound quality: 
• De-click – reduces spiky distortions that occur when digitizing LPs. 
• De-crackle – reduces crackling distortions that occur when digitizing LPs. 
• De-hiss – reduces general noise from LPs, cassettes & other sources. 
• Exciter – improves sound quality at higher frequencies. 
• Wideness – improves stereo basis of older recordings. 
• Sub-bass – improves sound quality at lower frequencies. 
 
Start playing a track that you want to filter.  You can preview a filter by checking either the 
Noise Reducer or the Sound Enhancer and adjusting the sliders.  When you are satisfied 
with the filter settings, click the Apply button.  By default, CD Spin Doctor will create a copy 
of the audio file and then apply the filters, so your original unfiltered recording is available. 
 
8.  Send to iTunes. 

Click the Send to iTunes button. 

 
 
CD Spin Doctor will automatically transfer all defined tracks to iTunes.  The transferred 
tracks will also be added to a playlist in iTunes called “CD Spin Doctor.” 
 
 
 
For more usage information, select “CD Spin Doctor Help” from the “Help” menu. 
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Rediscover Your Music - Create Instant Playlists – MusicMagic Mixer 
 
Pick a song, artist or album and instantly create playlists with MusicMagic Mixer.  
Automatically analyze the sound wave of tracks in your music library, and create instant 
original mixes from songs with similar acoustic personalities.  Send these unique playlists to 
iTunes and your iPod for a truly personalized listening experience.  
 
MusicMagic Mixer’s patented algorithms recognize dozens of acoustic characteristics, such 
as tempo, energy, and harmonics, and use these characteristics to create instant mixes of 
songs that simply sound great together.  It’s like having your own personal DJ. 
 
With MusicMagic Mixer you can: 
• Create fresh compelling playlists of songs that are “meant” to be played together. 
• Rediscover your music library in new exciting ways. 
• Truly “smart” playlists to fit your mood, instead of random auto-fill. 
 
MusicMagic Mixer features: 
• Music attribute analysis – scans the sound wave of songs in your iTunes library. 
• Creates perfect mixes of songs with similar acoustic properties from a “seed” of your 

choice – seeds can be one or more songs, artists or albums. 
• Set the length of the mix by number of tracks, player capacity or listening time. 
• Multiple shuffle modes – random, smooth, sawtooth and jagged. 
• Modify mixes by attributes with 'More Like This' and 'Less Like This'.    
• Modify mixes by 'Replace This Song' and 'Replace This Artist'.     
• Send mix playlists to iTunes and iPod. 
 
1. Launch MusicMagic Mixer. 
 
 
 
 

 

Send mix 
to iTunes 

Create 
new mix 

Shuffle 
mix 
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2. Analyze your music. 
 
If this is the first time that MusicMagic Mixer is run, the songs in your music library will be 
analyzed.  The sound wave of the songs will be scanned and matched against an online 
database of music1 and each song will receive a unique “fingerprint.” 
 

 
 
This process can take several hours, depending on the size of your library and whether 
these tracks have already been analyzed and identified by other users.  When a sufficient 
number of songs in your library have been analyzed, the status window will highlight the 
“Instant Mix” button.  You can click this button to create an instant mix from a random 
seed, or you can choose your own seed songs and create a mix. 
 
3. Create a new mix. 
 
In the “Genre” column, select “All” and you’ll see all the songs from your music library in 
the track list below.  Scroll through the track list and choose a “seed” song to use as the 
basis for your mix.  Click the “New Mix” button and MusicMagic Mixer will fill the track list 
with an original mix of songs that are acoustically similar to the seed you had selected. 
 
This mix is more sophisticated than the basic auto-fill options in iTunes.  It is not based on 
meta information, but on matching songs with similar acoustic personalities to produce a 
diverse assortment of genres and artists that match the seed you have selected. 
 
For example, if you were having friends over for a dinner party, you could pick a “seed” 
based on the type of mood you want for the party, such as a mellow song, and instantly 
create an original playlist of songs with similar acoustics. 
 
In another example, if you wanted a high-energy mix for exercising, you could pick a high 
energy “seed”, create a playlist in seconds, and send to iTunes. 
 
You can also select an artist or album as the seed for your mix. 

                                            
1 No personal identifying information is sent to the online database - only information for 
the purpose of song analysis. This may include song title, artist name, album name, track 
number, genre name, song duration, and song fingerprint.  
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4. Refine your mix. 
 
Refine your mix by control-clicking on any song in the track list and choosing “More Like,” 
“Less Like,” or “Replacement” options from the pop-up menu.  This will shape your mix to 
your tastes.  Of course you can select a new seed and choose “New Mix” to start again. 
 

 
 
 
You can set the MusicMagic Mixer preferences to refine your new mixes. 
 

 
 
You can also set the playlist to be of a certain length (by number of tracks, by time or in 
MB).  This is ideal for the iPod mini and iPod shuffle, which have limited storage.  Now 
instead of random auto-fill, you can have perfect playlists to fill all the available space. 

 
5. Shuffle your mix. 
 
When you have the song list you like, you can easily change the shuffle order by clicking the 
Shuffle button.  MusicMagic Mixer includes 4 powerful shuffle modes – including: 
• Random - simple random shuffle  
• Sawtooth - random shuffle, alternate between loud and quiet songs. 
• Smooth - shuffle to minimize the changes between each adjacent song  
• Jagged - shuffle to maximize the changes between each adjacent song   
 
You can choose which Shuffle mode you prefer in the MusicMagic Mixer shuffle preferences. 
 
6. Send to iTunes. 
 
You can send your new perfect playlist to iTunes by clicking on the “Send to iTunes” button. 
 
 
For more usage information, select “MusicMagic Help” from the “Help” menu. 
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Go Beyond Music - Capture Audio – Audio Hijack 
 
Capture and save the audio from an application with Audio Hijack.  Save Internet music or 
radio shows to enjoy at any time, capture sound clips from your DVDs, and set timers to 
record even when you’re away from your computer.  Send your captured audio over to 
iTunes automatically and transfer to your iPod. 
 
With Audio Hijack you can: 
• Capture the audio from any application and listen to it when you want. 
• Schedule unattended recordings – like a VCR – but much easer to program. 
 
Audio Hijack features: 
• Record and save the audio from any application. 
• Capture audio directly from the source – so you only hear what you want, and avoid 

what you don’t – such as system alerts, iChat beeps, or mail notifications.  
• Instant capture button to record immediately whenever the urge hits. 
• Scheduler to launch an application and record any time. 
• Professional quality equalizer and excitifiers to enhance captured audio. 
• Automatically send captured audio to iTunes and iPod, or launch any AppleScript. 
 
1.  Launch Audio Hijack. 
 
When Audio Hijack loads, you'll see the Sessions List. This window shows all the saved 
Sessions in Audio Hijack, as well as providing the controls for capturing and recording. 
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Instant 
Capture  

Input 
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Capture 
Settings 
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2. Choose Your Source. 
 
Drag and drop an application that can produce audio onto the Sessions List. 
 

 

 
 

 
 
3. Choose Your Capture Settings. 
 
In the Inspector window you can choose a URL or file to capture from, set timers to 
schedule the recording, set options to send to iTunes after capturing, and apply effects. 
 

Source 
 

Timer Recording Effects 

    
 
Click on the Source tab to set your source URL from an Internet stream, or add an audio or 
video file from your hard disk to capture from.  In Windows Media Player, choose Get Info to 
get the URL for a stream.  In RealOne Player, choose Clip Info to get the URL for a stream.  
In iTunes, choose Get Info on a stream in the Radio section or in the playlist to get its URL. 
 
In the example above, the KQED public radio audio stream is copied from the player and 
pasted into the “Open URL” section.  Now, when either the Instant Capture button is clicked 
or during a scheduled capture, this audio stream will be loaded before recording begins. 
 
Click on the Timer tab to schedule recurring recordings.  If you want to capture only once, 
you can skip this step.  Set the days of the week and the times you wish to record.  You can 
choose to record at the appropriate time (or simply launch the application and start playing 
like an alarm clock), mute the output while recording, and quit upon completion. 
 
Timers will not wake the machine from sleep or launch Audio Hijack.  Turn the monitor off 
to save energy but make sure your Energy Saver settings are set to not put the machine to 
sleep.  You'll also need to leave Audio Hijack running. 
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Click on the Recording tab to set what happens when recording is finished.  You can 
automatically add the captured audio to your iTunes library. 
 
Click on the Effects tab to adjust the sound quality of the captured audio. 
 
4. Start Capturing. 
 
Click the Hijack button in the Sessions List and the source application will launch.  The 
button will now say “Release”.  Audio Hijack now has control of the application's audio. 
 
Click on the “Record” button and start your application playing.  You will see the level 
meters moving.  Audio Hijack is capturing the audio playing in your source application.  
When you have finished capturing, click on the “Record” button again to stop capturing.  
The captured audio is automatically saved.  Click on the “Release” button to stop. 
 

 
 
If you’ve chosen to send your audio to iTunes, Audio Hijack will automatically launch iTunes, 
transfer you audio to your library, and encode the audio in either MP3, AAC, WAV or Apple 
Lossless formats.  Note that the original AIFF file will remain until you delete it manually.  
 
 
For more usage information, select “Audio Hijack Manual” from the “Help” menu. 
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Go Beyond Music - Download Podcasts - iPodderX 
 
Podcasting is the new phenomenon of professional and homemade broadcasts (usually 
audio in MP3 format) posted to the Internet.  Podcasts cover music, sports, humor, politics, 
movies, technology, and just about anything imaginable.  Unlike streaming Internet radio, 
new podcasts are automatically downloaded to your iPod so you can listen when you want. 
 
Join the podcast revolution with iPodderX.  Browse and search the largest directory of 
podcasters from around the world.  Learn a new language, catch up on the discussion of last 
night’s game, or hear news from around the world.  Subscribe to your favorites for fresh 
content delivered daily to iTunes and your iPod, and take your podcasts to go. 
 
With iPodderX you can: 
• Download fresh compelling content for your iPod, automatically. 
• Create your own personalized radio station. 
 
iPodderX features: 
• Massive directory of podcasters, updated daily – filled with thousands of amateur and 

professional podcasters, such as NPR, Infinity Broadcasting, and the BBC. 
• Subscription manager to track and download new shows from your favorite podcasters. 
• Intelligent storage management to optimize hard disk storage. 
• Supports audio podcasts and enhanced photo and video podcasts. 
• Integrated media viewer to watch video podcasts. 
• Automatically transfers podcasts to iTunes and iPod. 
 
1. Launch iPodderX. 
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2. Browse the podcast directory. 
 
Click on the directory pop-up and choose a category.  The top half of the window fills with a 
list of all the podcasters in this category.  To see more information about the most recent 
podcast from a particular podcaster, click on a row.  Check back frequently, since new 
podcasts are being added to this directory every day. 
 
 

 
 
You can learn more about this podcaster by clicking on the “Visit this Website” button, or 
preview a sample of the latest podcast by clicking on the “Preview Latest Podcast” button. 
 
3. Subscribe to a podcaster. 
 
Click on the “Subscribe to this Feed” button.  The subscription sheet appears.  You can 
customize this subscription by clicking on the Downloads tab, or simply click the  “Add” 
button to add this podcaster to your Subscription list. 
 
The most recent podcast from this podcaster will now be automatically downloaded to your 
hard disk, and then transferred over to iTunes.  A playlist with the name of the podcaster is 
also added to your iTunes playlists. 
 
You can now repeat steps 2 and 3 and add as many podcasters as you desire.  Every time 
you launch iPodderX, the software will automatically check for new podcasts from any 
podcaster in your subscription list.  New podcasts will be downloaded and fresh content will 
be delivered right to your iTunes library for on-the-go listening with your iPod. 
 
You can also click on the name of any podcaster in your subscription list, and the top half of 
the window will be filled with all the podcasts available. 
 

  
 
For more usage information, select “iPodderX Help” from the “Help” menu. 
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Go Beyond Music - Hear It – iSpeak It 
 
Turn any written document, e-mail or web page into a spoken audio file using iSpeak It.  
Create your own audio books, listen to the news, or have your email read to you while 
you’re commuting.  Instead of reading it – you can now listen to it on your iPod. 
 
With iSpeak It you can: 
• Enhance the iPod functionality by turning text documents into spoken audio. 
• Catch up on written documents while on the go. 
• An affordable alternative to audio books purchased from commercial services. 
 
iSpeak It features: 
• Built-in support for Word, AppleWorks, RTF, HTML, RSS feed or text.  
• Automatically load web pages, RSS feeds, Google news, and weather services on launch. 
• Links to Project Gutenberg directory of non-copyrighted e-books. 
• Powerful replacement rules, for more accurate text-to-speech conversion. 
• Automatically split audio into multiple tracks, just like audiobooks.  
• “Bookmarkable” audio, so you can continue where you left off, just like audiobooks. 
• Send to iTunes and iPod with a single-click.  
 
1. Launch iSpeak It. 
 
 
 
 

 
 

2. Choose what you want to convert to spoken audio. 
 
To convert an existing document, click the “Load Document” button.  You can also copy and 
paste into the iSpeak It main window. 
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Download or copy & paste 
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3. Convert the text to speech. 
 
Click on the “Transfer to iTunes” button.  
 

 
 
You can optionally enter information about this audio file, such as artist and album 
information.  You can also choose the audio format to encode with, such as AAC, MP3 or 
Apple Lossless.  If you choose AAC, you can make the file “bookmarkable” so you can save 
your place in the file and continue where you left off while listening on your iPod. 
 
You can also choose to split the file into tracks every few paragraphs, like an audiobook.  
 
When you are ready, click the “Transfer” button.  iSpeak It converts the written document 
into a spoken audio file, using the Mac OS X built-in speech technologies. 
 
For more usage information, select “iSpeak It Help” from the “Help” menu. 
 
 
A Note On Mac OS X Speech Technologies 
The Mac OS has powerful text-to-speech conversion capabilities.  You can choose the voice 
that iSpeak It uses to convert text from the “Speech Preferences” in the “iSpeak It” menu. 
You can test any voice prior to converting by choosing “Test Speech” from the “File” menu. 
 
The default voices supplied by Apple with the Mac OS are adequate for most listeners – 
Victoria is a good choice.  Higher quality Mac OS X voices that work perfectly with iSpeak It 
are available from Cepstral at http://www.cepstral.com. 
 
Cepstral is offering their voices at a special discount for Roxio customers.  Details are 
included in the “Special Offers” folder on The Boom Box disc. 
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Recording Setup Addendum for CD Spin Doctor 
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